
Getting Started

WWSaver32 is a screen saver.    Access to the program’s configuration must be done through the Control Panel’s Display Properties 
dialog.    You normally access it through the Control Panel in My Computer, or you    may right-click the desktop and choose 
Properties.    In the Display Properties Dialog, select WWSaver32 from the list of available screen savers, then click the Settings 
button to see the program’s configuration dialog. 

If you find that you are frequently changing the configuration you may want to place a shortcut to the screen saver on your desktop. 
Open your Windows\System directory and find the file WWSAVER32.SCR.    Right-Drag it to the desktop and choose “Create 
Shortcut(s) here.”    Place the icon to your liking.    Now, to configure or test the screen saver, simply right click and choose the 
appropriate action from the popup menu.

Nothing will happen with the screen saver until you add one or more files to the image queue.    To do this, select the Images tab on 
the configuration dialog, then click the "folder" icon at the left top of the dialog.    Browse for image files to add to the image queue.    
There will normally be images in your Windows directory, and you may have others which you have obtained.    If the images are 
small ones which you would like to have "tiled," check that option in the dialog (you can also change the tiling later).    After you have 
selected OK in the dialog, you will see the files listed in the queue. 

Take a moment to familiarize yourself with the configuration elements on screen.    If you press the F1 key, this help file will be 
displayed, with information about the part of the program you are using.

The Screen Saver Configuration Dialog topic will explain the other tabs that are on this dialog.

There are a number of options for how an image may be displayed.    Look for these topics in the help file:

Tiling.

Resizing images.

Adjusting Image Placement.

Gamma Adjustments.

There are a number of items in the Image Display and File menus that affect the way the program operates.



Program Description

WWSaver32 is a screen saver which uses picture files.    Picrture files are maintained in convenient “Queues” that allow grouping by 
topic. Fifteen transitional effects are available for screen saver changes.    Images may be in a number of standard formats, including 
GIF, JPG,    and BMP.

WWSaver32 has a provision for reducing the colors in a 256-color image to 16 for VGA display, and for reducing True-Color (16 
million colors) images to 256 (or 16) colors.

There is a Thumbnail function, which will display a small copy of all the images in a queue for easy management.

Multiple "queues" (configuration files) may be maintained, each saved under a distinctive name.    Queues may contain up to 6000 
files each.



Thumbnail Display

Small images of each of the bitmaps in your Image Queue are shown when you select the "View image thumbnails" option on the 
File menu.    Depending on your computer speed and the number of images, it may take quite a while to load all of the images until 
they have been built once.    See Dynamic Thumbnailing for more information about how thumbnails are built.    Subsequent displays 
will be much faster.    You may stop the load at any time by pressing the "Cancel Load" menu option (only visible while the images 
are loading), or pressing the Escape key, which will erase the Thumbnail screen.

The display of images is coordinated with the Image Queue list.    The image listed at the top of the queue will be found in the top 
row of the resulting display.    It may not be the first image, since the thumbnail screen works in sets of 5.



ASP Ombudsman Statement

This program is produced by a member of the Association of Shareware Professionals (ASP). ASP wants to make sure that the 
shareware principle works for you. If you are unable to resolve a shareware-related problem with an ASP member by contacting the 
member directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or problem with an ASP member, 
but does not provide technical support for members' products. Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536



Dynamic Thumbnailing

WWSaver32 creates a small thumbnail image for each of the files in a queue.    Because it takes time to read a file and make the 
small thumbnail, the program waits until the file is being read for another purpose and then makes the thumbnail and stores it in 
the ..QU2 database file. 

There are three circumstances when a thumbnail will be created: When the image is used by the screen saver; when the thumbnail 
screen is invoked (see ThumbNail Display); and when the image Properties frame is shown by clicking a single filename in the 
queue list.

If an image is changed by editing, the program will detect that a change has occurred and rebuild the thumbnail when one of the 
three circumstances next occurs



Speed vs. File Size

There is a tradeoff between program speed and the amount of compression used on images.    Uncompressed .BMP files will display 
far more rapidly than the most compressed .GIF or PNG files, with .PCX between for both speed and compression.    .TIF and .TGA 
are normally used for pictures containing 32,000 or more colors; neither offers significant compression over .BMP, and both are 
slower.    For 24-bit (16-million color) images, WWSaver32 can use .JPG format, which offers great compression, but is very slow 
and will cause some loss of image quality.

Note for users of compressed disk programs (Stacker, DOS 6 DoubleSpace, etc):    There is no space advantage to using 
compressed file formats with compressed drives (other than JPEG - see File Formats). You will lose the speed without gaining 
space, since your compression program cannot further compress a .GIF file.

If you have chosen an image file with more colors than your display can show there will be additional delay while the program 
changes the color depth.

For more information about the pros and cons of the file types, see File Formats.



Display Order

The Display Order option in the Image Display menu or on the toolbar allows you to choose Random or Sequential display.    
Random display will cycle through the list of images in no apparent order.    Sequential will display them in the order in which they 
are added to the Image Queue.    When changing from random to sequential, the display will continue from the currently displayed 
image.    Sequential order is good for slide show effects.    When Sequential is chosen there will be a “Start with first image” item in 
the Image Display menu.    If this is checked, the screen saver will always start with the first image in the queue, otherwise it 
continues from where the last screen saver session ended.



Up and Down Buttons

Use these buttons to organize the files in a queue in a desired order (for sequential display, or simply to manage the files better).    
The buttons will only be visible when one or more files are selected in the queue.    If several non-contiguous files are selected and 
an up or down arrow is repeatedly clicked or held down, the files will maintain their separation until reaching the top or bottom of the 
list, at which point they will bunch together until all are contiguous at the beginning or end.



List Details

This option in the File menu has two options, File Name Only and Full Path and File Name.    File Name Only will remove drive and 
path information, while Full Path will include all directory/subdirectory information for each file.    In the latter case, the file name may 
be scrolled off to the right of the queue, making the entries difficult to read.



Add Button

The "Add" Button is used to add a new image to the Image Queue.    Pressing this button is the same as choosing "Add Image File" 
from the File menu; the keyboard shortcut is CTRL-A.    Pressing this button will cause a dialog box to appear for browsing through 
drives and directories looking for bitmap files which can be selected for addition to the queue.    Files can 
have ,BMP, .RLE, .GIF, .PNG, .PCX, .TIF, .ICO, .TGA, or .JPG extensions.    You may use the tiling option buttons to turn tiling on or 
off for the added files - the default will be the queue default for tiling.    You may change the tiling for a file or files later by selecting in 
the queue list and changing the Properties. The image will be positioned according to the setting of the default origin point.

You may add an image to the queue more than once to increase its display frequency.



Queue File Menu Options

WWSaver32 allows multiple configuration file called "queues," which are maintained in files with a QU2 extension.    Image files may 
appear in many different queues.    When a queue is loaded, its name will appear in the status line above the WWSaver32 queue file 
list.    Clicking on this name will pop up a list of all .QU2 files that are in the same directory, for immediate change. 

There are five menu options in the File menu for use with queues: "Start New Queue File," "Change Queue File," “Clear Queue 
File,” "Save Queue File As” and “Delete Queue File.”    The Change Queue File option may be used to change to queues that are not 
located in the same directory as the current queue.

Each image file will use about 5K of disk space in the .QU2 file.    If you delete an image this space is not recovered, although it does 
get used when a new file is added (before any more space is used at the end of the file).    Using the Clear Queue File option will 
remove all of the file information and reduce the .QU2 file size to a minimum.    Use this option when you want to start over adding a 
new list of files.    Delete Queue File means to remove the .QU2 file from your hard drive.    Both commands will prompt for 
confirmation, and the latter command will follow with a dialog to select a new queue.    If that operation is canceled, the queue will 
become “Untitled.”    If an “Untitled” queue actually exists in your WWSaver32 directory it will become the active queue.

Save Queue File As will make a new copy of the existing .QU2 file under a new name which you select.    It will not delete the 
previous named queue file.    If you are using the function to rename a queue you should change back to the previous queue and 
delete it, or delete it using Explorer functions.



Deleting Images

The "Delete Image File" option in the File Menu will be disabled (grayed) unless an entry has been selected in the Image Queue.    
The keyboard shortcut is CTRL-D, or the Delete key..    If a selection has been made, that image will be deleted. 

The program will offer two choices: delete from queue only or from the queue and your hard drive.    The latter will delete the file, 
while the default action to remove from queue only will still leave the file in its folder.

Multiple file selections are allowed in the queue list.    The chosen action (Delete from queue only, or Delete from hard drive) will be 
performed on all selected files.



The Image Queue

The "Image Queue" is a list of bitmaps that you wish to use as screen saver images.    You can show all of the images in the queue 
in "Thumbnail" form by choosing View Image Thumbnails from the Images menu.    You can add any appropriate bitmap image to the 
list via the Add Button.    You can make a specific image occur more often by adding it to the queue more than once.    You may also 
add images to the queue by means of “ Drag and Drop” from Explorer.

The maximum number of files which may be in a queue is 6000.    Queue performance deteriorates, particularly load time, with the 
size of the queue.    Most queues will perform best if they have 1000 or fewer images in them.

A small icon appears to the left of each queue entry.    This icon is a visual indicator of the files resize status.    When a file is first 
placed in the queue, the icon will be a question mark, meaning that until the image has been accessed its resizing is unknown.    
Once the image has been accessed, the icon will be one of three:    A blank square, which means the image does not resize, a four-
headed green arrow, meaning it does resize, or a dark blue cross-hatch, meaning the image is tiled (doesn’t resize when tiled), or a 
dark green cross-hatch, which means resized AND tiled.    The image’s Properties dialog provides detail on how an image will be 
resized.

For the following actions you must first select an image in the queue.    This means that you must click once on a file name, then 
perform the action:

Delete 

Resize Image 

Position Image 

Use Sound with Image

Tiling on/off 

All of these options except position will work on multiple files at once, if they are selected.    The queue list is an “Extended 
Selection” list box; holding the shift key down while clicking another will select all that are in-between; holding the control key down 
will allow selecting multiple individual files.

Selections may also be made using the keyboard up and down arrows, holding the shift key down to make continuous selection or 
holding the control key down and using the space bar for selection.



Tiling on/off Option

Images may be displayed either Tiled, or not.    The Tiling Off option means that the image will be shown once at the origin point (see 
Adjusting image placement on screen).    With Tiling on, an image that is smaller than the screen size will be shown in multiple 
images to fill the entire screen.    The condition of this setting when a new image is added to the queue will determine the initial 
setting for that image. 

To change an image’s setting, select it in the queue and then change the switch, either in the Properties frame or via the Image 
Display menu.    You may choose multiple images in the queue and apply a setting to all of them at once.

If you have Resizing enabled, tiling will not override it.    If the image is resized to full screen or larger, the tiling will not be apparent.



Registration

Don Bradner
Arcata Pet
600 F Street
Arcata,CA 95521-6301

WWSaver32 copyright ©1992-1997 by Don Bradner.    WWSaver32 is Shareware.    Click here to print a Registration Form and send 
it with $29.95 to the author at the above address.    California residents please add $2.17 for state sales tax, and Non-US users 
please add $3.00 for Air Mail service. See Author Support for information on contacting the author

CompuServe members may register on-line.    Go SWREG, the program registration number is 13356.

Internet users may order online at www.arcatapet.com.    This order goes directly to the author and is processed quickly.    Fully 
secure ordering is offered, as well as plain text if your browser does not support security.    All major credit cards accepted.

Regardless of the method of registration, you will receive a copy of the most recent version of WWSaver32 and a registration key 
that will eliminate the startup screen. This registration key will work for all future versions of WWSaver32 as well.    See Upgrading to 
new versions.    If you have the latest version you may choose to have a registration key sent by e-mail.

Other goodies: you may include 2 photos or slides of your own for free scanning.    The photos will be returned along with JPG scans 
for your use.    WWSaver32 is “cross-registered” with WWPlus32, a complete wallpaper utility that shares QU2 files with 
WWSaver32.    This means that registered users of either program are automatically registered for the other, and may use their key 
files with both programs.

Commercial use:    WWSaver32 may be used commercially, as long as there is a registered copy for each computer/terminal that is 
using it.    Site licensing programs are also available.



Author Support

The author is very interested in supporting registered users of this program, and reasonable support is also available to unregistered 
users with problems.    Feel free to contact him in any of the following ways:

Mail:

Don Bradner

Arcata Pet

600 F Street

Arcata, CA 95521-6301

Phone: (707) 822-6417.    This phone is normally answered by the author, or by a machine if the author is not available.    Calls will 
be returned in the US - leave your name/number and best times to call..

Compuserve: 76130,1007

Internet mail: dbirdman@arcatapet.com 

Home Page: http://www.arcatapet.com



Load File dialog box

The Load file dialog is shown when the Add button is clicked.    You may browse through your directories to find any image file which 
WWSaver32 recognizes.    A handy preview function is included.    Select a file and click the Preview button.    A small "thumbnail" 
version of the file will appear in the box above the button.    When you have found an image that you wish to load, click OK.    To exit 
the dialog without making a selection, click Cancel.

Multiple file selection is allowed.    If the files are not contiguous in the directory, hold down the CTRL key while clicking each file.    To 
select a large number at once, click the first one and then scroll to the last one; hold down the Shift key and click the last one.    The 
maximum number of files which may be in a queue is 6000.    Queue performance deteriorates, particularly load time, with the size 
of the queue.    Most queues will perform best if they have 500 or fewer images in them.



File Menu

The File menu contains items for adding and deleting files from the queue.    It also contains items for creating and deleting queue 
files themselves, as well as items which control the display of the files in the queue. 

Menu items include:

Add Image File 

Edit Image File 

ReLink Image File 

View Image Thumbnails

Delete Image File 

List Details

Start New Queue File

ChangeQueueFile

Clear Queue File

Save Queue File As

Delete Queue File

Temporary Wallpaper Folder



Image Display Menu

This menu contains items that affect the way WWSaver32 works.    It allows you to change a number of defaults to customize the 
program to your own liking.    Click any of the topics below to get information on that topic.

Default Resize Options

Resize Selected Images

Default Sound

Sounds for Selected Images

Display Order

Start With First Image

Set Default Position

Position Selected Image

Tiling

Correct Screen Gamma



Set Default Position

This item in the Image Display menu sets the default location for each newly added image.    You may change the individual setting 
later - see Adjusting image placement on screen



Start With First Image

This item in the Image Display menu determines whether a sequential display is always started with the first image in the queue.    
When it is not checked, the first image displayed at screen saver activation will be the next in order following the last one displayed 
in a previous session.    This option has no effect when Random Display is selected.



Help Menu

The Help Menu provides two options: Help topics, which displays the helpfile dialog; and About, which provides current version 
information for WWSaver32.    The help icon (question mark) is the same thing as Help Topics.



File Formats

Information on the file formats supported by WWSaver32:

.BMP and .RLE

Files with .BMP extensions are bitmapped images created by tools like Windows Paintbrush.    .BMP is the native format for 
Windows wallpaper.    There are a few .BMP files distributed with Windows specifically for use as wallpaper.

This is the fastest format available, but requires the most disk space.    It does not require any conversion or decompression by 
WWSaver32, so the only time required to display a new image is the time it takes to read the image from the disk.    Excellent for 
small images that are "tiled" (displayed as multiple images to cover the desktop space).    This format is usable for all color levels 
from 16 to 16-million.    .RLE is a compressed form of .BMP.

.GIF

The Compuserve Graphics Interchange Format, pronounced "Jiff," offers great compression of images up to 256 colors without loss 
of quality.    It is not usable for images with more colors.    This format is generally the best choice when disk space is limited and the 
image has no more than 256 colors.    There is a noticeable delay while WWSaver32 decompresses the image for display, although 
the faster the computer the shorter the delay.    The .GIF format contains compression technology that is patented by the Unisys 
corporation, and as of 1/1/95 became liable for royalty    payments by software developers.    See the full statement in the 
README.TXT file.

.ICO

These are Windows icon files, 32x32 pixels and 16 colors.    You may use these as tiled images with WWSaver32. 

.JPG

Files with .JPG extensions are "JPEG" compressed.    JPEG stands for Joint Photographic Experts Committee.    This format is most 
suitable for 24-bit (16-million color) images.    It is "lossy," which means that the compression involves some loss of quality.    The 
resulting file size is quite small, but takes a long time to decompress and display. JPEG is particularly unsuited for images with large 
areas of solid colors and sharp edges.

JPEG does a very good job of compression, and with most pictures the resulting image is comparable to the original. 

There are many non-standard forms of JPEG.    WWSaver32 should read any JPEG image conforming to the JFIF standard, but 
may not be able to read images produced by non-standard programs.    An example would be GIF2JPG, which can produce a 
proprietary JPEG file called HSI.    Older versions of the program did this by default; newer versions produce JFIF compatible files by 
default.

.PCX

.PCX is a format developed by the Z-Soft corporation for their line of PC Paintbrush programs.    Windows Paintbrush is also able to 
read and save this format.    It provides some compression for images with color levels up to 256 when compared to ,BMP files, but 
not as much as a ,GIF.    There is less noticeable delay when using .PCX than with .GIF. The .PCX format can use color levels up to 
16 million, but file size actually increases when 24-bit files are used.

.TIF and .TGA

.TIF is the extension used with Tagged Information File Format (TIFF) files    .TGA is called "Targa."    Both are primarily formats for 
storing 24-bit (true-color) 16-million color images and gray-scale images in desktop publishing.    WWSaver32 can read the formats, 
but there is no space advantage and they will load slower than .BMP.    Tiff files may contain more than one picture.    If that is the 
case, WWSaver32 will only read the first image. .TIF is usable for all color levels, 16 to 16-million, while .TGA is usable from 256 to 
16-million.

.PNG

.PNG (Portable Network Graphics) is a new format designed as a successor to .GIF.    Unlike .GIF, it is not burdened by LZW-
compression licensing requirements.    It also takes advantage of newer compression techniques to make a file size generally 
smaller than .GIF at 256-colors.    Unlike .GIF, the format may also be used to produce loss-less 16-million color images.    These 
images will be far larger than .JPG images, but will be somewhat smaller than .BMP, .PCX, .TGA and .TIF uncompressed images 
and are lossless.



Editing Images

The author of WWSaver32 also produces a 32-bit graphics viewer/editor/printer called ImgViewer/32.    When ImgViewer/32 is 
installed, WWSaver32 will recognize it and add a File Menu item for easy access to the editor.    When a file is highlighted, that file 
will automatically be loaded into the editor as it is opened.    You can use the editor to convert file formats, or to alter the 
brightness/contrast/gamma; cropping is also available.

ImgViewer/32 can be found in most on-line sites where WWSaver32 is found.    Like WWSaver32, it is uncrippled shareware.



The Author



Bitmaps

A bitmap is an image stored as a pattern of dots.    These images can be stored in a number of graphics formats..    With 
WWSaver32, you may use .GIF, .PCX, .BMP, RLE, ICO, TIF, .TGA, .PNG, and .JPG.

Where to get bitmaps

Several .BMP files are included with Windows for use as wallpaper.    Additionally, you can draw your own bitmaps with Windows 
Paintbrush.    If you have a scanner, you can scan images and store them as bitmaps.    Many computer stores and printing 
businesses offer custom scanning to order.    On-line services have thousands of files which can be used as screen savers.    Most of 
these files will be in .GIF or JPG format.

If desired, the author of WWSaver32 will provide two free scans when registering the program.      See the Registration Form for 
more details.

A number photos are available from the author's internet home page: http://www.arcatapet.com



Files and Uninstalling

When WWSaver32 is installed, a program (UNINSTAL.EXE) and a data file (INSTALL.LOG) are placed in the WWSaver32 directory. 
The following information is provided to aid in removing the program in case those files are lost or damaged.

Files distributed with WWSaver32

WWSETUP.EXE This file contains all of the program files.    Running it will install all of the files where they belong, and will also 
produce a record and program that can be used to uninstall this package.

README.TXT a text file that explains the program.    It is placed outside the main install program so that it is readable before the 
program is installed.

VENDINFO.DIZ, FILEID.DIZ Information files for shareware distributors and online services.    These explain distribution rights and 
allowable methods.

Files installed by WWSaver32

Main Program directory files
WWSAVER32.HLP, WWSAVER32.CNT, README.TXT, UNINSTAL.EXE, INSTALL.LOG, GAMMA.PCX.

Windows\System directory files
COMCTL32.OCX, COMCAT.DLL, IK32.OCX, MFC40.DLL, MSVCRT40.DLL, MSVCRT.DLL, MSVCIRT.DLL, WININET.DLL, 
OLEPRO32.DLL, OLEAUT32.DLL, MSVBVM50.DLL, WWPLIB32.DLL, WWSAVER32.SCR.

Registered users will have one additional file: WWP_REG.KEY.    This file must be in your WWSaver32 directory, and will keep all 
shareware screens from appearing.    If you upgrade to a new version of WWSaver32, do not delete this file - it will work with all 
future versions. 

Files created by WWSaver32

WWSaver32.BMP    This is a "temporary" file that WWSaver32 uses to translate non-standard images so that they can be used by 
Windows as wallpaper.    It is created whenever the option to use the last screen saver image as wallpaper is selected.    By default it 
is located in the directory identified in your TEMP variable, but you may change this default using the Temporary Files Folder item in 
the File menu.    NT Note the Temp variable is not available to a screen saver, so the WWSaver32 directory will be the default 
instead.

*.QU2 These are queue files used to store information about images in a queue.    They do not have to be in any particular directory, 
but the default is your WWSaver32 directory.

Uninstalling WWSaver32
If the UNINSTAL.EXE program and INSTALL.LOG file have been left intact in the WWSaver32 directory, running that program will 
remove all files that were installed with WWSaver32.    If the UNINSTAL program has been removed, use the file list above to 
determine which files to remove.



Distribution

WWSaver32 is shareware and may be freely distributed as long as all of the files are included and no fee is charged beyond a 
reasonable fee for distribution.    Registered users note:    Do not distribute your WWP_REG.KEY file.

All rights are reserved by the author (see Registration).



Troubleshooting

If your difficulties are related to slow operations with specific images, see Speed vs. File Size

The time it takes to load and display the configuration dialog is related to the number of files in the queue.    On very fast computers 
large queues may be acceptable, while users of slower computers may choose to have multiple smaller queues.    The program’s 
maximum number of images per queue is 6000.    See also Tip: Speeding configuration dialog loading and Tip: Quick access to the 
configuration dialog.

Other difficulties running the program may be associated with a missing file, or a file that needs to be in the Windows or 
Windows\System directory but isn't.    See Files for details. 

If you have an image that WWSaver32 will not display, it may be in a format that cannot be used.    There are some variations 
of .GIF and .PCX that are known to make problems for WWSaver32.    There are many non-standard versions of JPEG that will 
cause problems.    If you can load them into another image editing program you may be able to save it in a usable format.

WWSaver32 expects image file names to match their formats.    If you have a .BMP image but give it a .GIF name, the program will 
not be able to read it.

If you move the program files to a different directory you should re-run the setup.



Adjusting image placement on screen

Changing the image's location

WWSaver32 contains options which allow you to change the position of non-tiled images by setting the image origin (upper left 
corner position).    Combining this option with the option to confine an image to a specific size (see Resizing Images) allows many 
different looks to be achieved. 

Setting the image origin

For all of the following, remember that a setting of 0 (zero) for X or Y coordinates will center an image on that axis.    You cannot set 
the upper left corner of an image to 0,0; use 1,0 or 0,1 instead.

First, select a default origin.    Click the Image Display menu on the configuration screen,    and then click Set Default Position, or 
click either the X or Y position in the frame when it is showing the Queue Defaults.    A dialog box will prompt you for settings and 
take care of the details. 

To select a specific origin for an image there are two options: dragging the image into position, or changing the settings. In either 
case, first select the file in the Image Queue. To drag the image into position, choose Position Image in the Image Display menu or 
click the “…” button next to the word “Position” in the Properties frame.    The program screen will be replaced by the image, which 
you may move by pressing and holding down your left mouse button.    When you have the image positioned where you want it, 
release the mouse button.    Double-click on the image or press the Enter key to "fix" the placement.    Press the escape key to exit 
without setting a new position.    Alternatively, you may position the image in the properties frame.. You may click either the X or Y 
coordinate boxes and use the resulting dialog to enter the numbers directly.    If either of the coordinates end up being zero, the 
dialog will read "centered" to remind you that it is not a true zero.



WWSaver32 Version 3.21

Order Form
To Print this form, use the Print button, above.

To edit in WordPad or a word processor, use the Options button and copy this form to the clipboard, then paste it into the word 
processor of your choice.    Edit and then print.

Price is US$29.95, including postage within the US.

With a credit card you may order toll-free in North America: (800) 822-9085

Outside of North America, or for technical support, please call: (707) 822-6417

FAX orders accepted at (707) 822-6570

You may order OnLine at www.arcatapet.com if you wish (Secure). 

By mail, with check, credit card, or money order in US Dollars to: 

Don Bradner/Arcata Pet

600 F Street

Arcata, CA 95521-6301 

Compuserve members may order on-line:    GO SWREG, program number is 13356.

Number of copies desired ____x 29.95 =                        $___________

California residents add $2.17/copy sales tax              ____________

Non-US add $3.00/copy for air mail                                                      ____________

              Total ____________

�Check here to have registration key e-mailed.    With this option, no disks will be sent,    and no non-US air mail fees need be paid. 
You must include a valid, readable e-mail address, below, and your e-mail software must be able to decode a binary attachment.    
Otherwise, software will be sent on 1.44 meg 3-1/2 inch disks.

Your Name:                                  ___________________________________________________

Mailing Address:            ___________________________________________________

City/State/ZIP/Country: __________________________________________________

Daytime phone number (______)_________________ E-Mail address, if any ___________

If paying with a credit card: Card type    �VISA        �MasterCard      �AMEX        �Discover

              Card Number:    ________________________________ Expiration Date: ________

              Signature to authorize charge: ________________________________________

(optional) Where did you get WWSaver32?

� BBS or other on-line service. .    Which one? ______________________

� Software/Shareware Service/CD_ROM.    Which one? ______________________

� Internet.    What site? __________________________________________

� Friend        � Other _________________________________________

You are welcome to include 2 prints or slides for free scanning if you would like.    Originals will be returned with your disk.    Please 
Specify the resolution desired (Maximum Horizontal/Vertical):

 __640x480    __800x600    __1024x768    __Other:_________

If none marked, image will fit 640x480.    image will be a 24-bit JPEG

Comments to the author are welcome.    Tell me what you like, or would like changed or added.

Thank you for ordering!



What Is Shareware?

Shareware distribution means “try before you buy.”    If you try a Shareware program and continue using it, the author expects to be 
compensated for his efforts to produce the program.    Individual programs differ on details -- some request registration while others 
require it, some specify a maximum trial period.    With registration, you get anything from the simple right to continue using the 
software to an updated program with printed material.    With WWSaver32, you get the latest version plus a registration key that 
disables the startup shareware message.

Shareware authors are accomplished programmers, just like commercial authors, and the programs are of comparable quality.    (In 
both cases, there are good programs and bad ones!)    Copyright laws apply to both Shareware and commercial software, with the 
copyright holder retaining all rights, with the exception that the shareware author specifically grants the right to copy and distribute 
the software, either to all and sundry or to a specific group, while copying of commercial software is generally prohibited.

Because the overhead is low, prices are low also.    Shareware has the ultimate money-back guarantee -- if you don't use the 
product, you don't pay for it.



Queue Title

The Queue Title is the file name for the queue currently in use.    See Changing Queues for general information on this topic.



Screen Saver Configuration Dialog

The Screen Saver Configuration dialog is accessed from the Display Properties dialog, either from Control Panel in My Computer, or 
by right-clicking an open area of the desktop and choosing Properties. 

There are four pages in the lower half of the dialog.    WWSaver32 remembers the page most recently used, and will open to that 
page.

Page 1, Images:

On this page you will find the images which are going to be used by WWSaver32.    For specific information, look at these topics:

Image Display Menu

File Menu

The Image Queue

Page 2, Entry Options:

Timer    - Turn the image-change timer on/off and set the time between image changes.    Range of values is 1-6000 seconds, 
default is 20 seconds.

Background color - Choose your regular desktop color (default) or black.    This area will surround any image that is less than full 
screen size.

Startup Image - Choose none, next image (default), or current wallpaper (default).    When none is selected, the screen will blank to 
a solid color, as selected under Background Color above.    With the other two the image will transition from a view of the current 
screen into either the next or current wallpaper.    When current wallpaper is chosen and there is no current wallpaper, a static image 
of the current desktop will be displayed until the Timer interval has passed.

Stop Changing After    This option will be primarily of interest to users with Energy Saver Monitors who have Shut Off Monitor 
enabled in the Control Panel.    When the monitor is shut off there is no reason for WWSaver32 to keep accessing the disk, and it 
can also be annoying if sound options are enabled to have the sounds continue.    Choose a setting slightly longer than the Shut Off 
Monitor period, so the screen saver will stop changing images soon after the monitor goes dark.

Page 3, Exit Options:

Mouse movement required to exit - Determines the amount of travel required to terminate the screen saver.    Movement is stored 
up, so a series of small moves will result in termination.    This storage is reset whenever the image changes.    The default is 
moderately sensitive.

Make wallpaper from last screen saver image - checking this box will cause the last-used screen saver image to become your 
wallpaper.

Page 4, Effects

Note: Transition effects are video intensive.    They may not work properly with slow video cards or with bad video drivers.    It is a 
good idea to check with your video card vendor routinely to keep up with changes in video drivers.

Effects - There are 15 available screen saver change effects.    When none are selected, the next image is displayed immediately 
when the change interval has been reached.    The effects cause the image change to be gradual, producing a more dynamic 
appearance.    More than one effect may be chosen, in which case WWSaver32 will randomly select an effect from among those 
choices at each change interval.    All effects are enabled by default.

Use Common Palette - This option is only available when the system uses a 256-color display.    Use of a common palette will avoid 
annoying palette shifts between images, but many images will not look as good as they do when they have their own palettes.    
Experiment to determine your preference.    This option has no meaning when there are no effects chosen.

Animate Preview Windows controls whether an instance of WWSaver32 is running in the preview window of this dialog and the 
Display Properties dialog.    If the box is unchecked, the small image will change once, and then stop.    If it is checked, the small 
image will continue to process files, with changes in the configuration being reflected at the next image change.    The default is on 
(checked), and the primary reason for unchecking it would be on slower computers where the animation may impair responsiveness 
while making configuration changes.    In either case, the miniature screen saver display is replaced by a specific image when one is 
selected in the queue list.



Drag and Drop

WWSaver32 supports Drag and Drop of files to the queue.    The configuration dialog must be running when this is done.    Select 
image files in Explorer and drag them by holding the left mouse button down until you are over the WWSaver32 window.    Release 
the mouse button, and the files will be added to the queue.    If you drop files that do not have extensions recognized by 
WWSaver32, those will be ignored without harm.



Resize Images

There are two Image Display menu items which allow great flexibility in the resizing of images.    The first menu item establishes 
queue defaults, while the second menu item is only available when an image or images are selected in the queue; they provide an 
override for the defaults.    They are also the same as using the Resizing Change button in the Properties frame.

The queue resize menu item allows separate options for images larger or smaller than a threshold level.    If either vertical or 
horizontal dimension is less than the threshold, the smaller option will be in effect.    You can specify that images will be resized to 
full screen or to an alternative size.    Alternative sizes allowed range from a minimum of 32x32 (icon sized) to a maximum of twice 
the current screen size.

You may also choose to have the image's aspect ratio maintained (Proportional) or have the image stretched to occupy the full area 
chosen (Stretch).

After selecting an image or images in the queue you may use the Resize Selected Images menu item, or the Resize button in the 
Properties frame, to choose something other than the default for those images.

To keep images confined to a specific area of the screen, first use this option to specify the maximum image size.    Then use the 
position options to set the position of the image.    See the information on setting origin points.

Using the Resize option will slightly increase the time it takes to display screen saver images, with faster computers being least 
affected.



Correct Screen Gamma

This option, available from the Image Display menu, allows all displayed images to be automatically adjusted for gamma, or 
midtone.    When this option is selected, a dialog will be displayed which contains an adjustment “target,” along with a slider bar to 
adjust the gamma level.    For the target to show up, there must be a file called gamma.pcx (included with WWSaver32) in your 
WWSAVER32 directory.    This target contains an area of neutral gray surrounded by an area of alternating black and white pixels.    
Slide the bar until the center area appears to be the same shade as the surrounding area, then click OK.    Displayed images will 
now be gamma corrected before display as screen savers.    If, after observing the results you feel that the images are under or 
over-corrected, reopen the dialog (unselect the menu item, and then re-select it) and make a small adjustment.    Smaller numbers 
will result in darker images.



NT and WWSaver32

WWSaver32 is generally compatible with Windows NT.    The exit option to have the last screen saver image become the wallpaper 
may not work every time, particularly if the screen saver is interrupted by pressing CTL-ALT-DEL.    This can result in the screen 
saver abruptly terminating and not having a chance to set the wallpaper.    Due to a bug in NT version 3.51 it will probably not ever 
become the wallpaper, but that is fixed in NT 4.    The .BMP file used for this will not be in the Temp directory, because that variable 
is not available to NT screen savers.    The file will be located in the WWSaver32 program directory (Overridable by the Temporary 
Files Folder item in the Files menu).

The program directory is stored in HKEY_LOCAL_MACHINE and is available to all users.    Queue and other configuration 
information is stored in HKEY_CURRENT_USER and is user-specific.

If password protection is enabled, you will get NT's “Locked Desktop” message, requiring CTL-ALT-DEL and your normal logon 
password to regain the desktop.



Using Sounds

Sound files, in .WAV format, may be used at the time of image changes.    Two configuration items control this option.    Default 
Sound, in the Image Display menu, or the Sound Change button in the queue default Properties frame, controls a global choice for 
sound usage, while the global default may be overridden by choosing Sounds for Selected Images in the Image Display or the 
Sound Change button in the Properties frame for an image or selected group of images.



The Image Properties Frame

One of the simplest ways to change the way an image is displayed is through the image’s properties frame.    To see the frame, click 
an image name in the queue..    The Properties frame will change from the Queue Default to the specific image properties, with a 
thumbnail of the image taking the place of the normal mini-screensaver display.    From this frame it is easy to set options for 
resizing, tiling, position, and sound.



Tip: Speeding configuration dialog loading

The biggest slowdown when loading the configuration screen is the loading of the files into the queue.    This is particularly slow with 
large queues.    If you are not working with specific images in the queue you do not need to load the queue, and the configuration 
dialog will display faster.    The dialog “remembers” which tab was selected and returns to that tab at next load.    If the tab is not the 
Images tab, the queue will not be loaded.    The queue will still load when the Images tab is selected.    So, before closing the dialog, 
select one of the other three tabs.



Tip: Quick access to the configuration dialog

When you are building and setting the properties of a queue you may want to frequently access the configuration dialog.    Opening 
the Display Properties, selecting the screen saver dialog, then Settings, is a time-consuming process.    To get quick, one-step 
access to the dialog, make a shortcut to WWSaver32 on the desktop.    Open your Windows\System directory in Explorer and locate 
the file WWSAVER32.SCR.    Press the right mouse button and drag the file to the desktop.    Release the mouse, and choose 
“Create Shortcut(s) Here” from the popup menu.    Now you can get to the configuration dialog by right-clicking the shortcut and 
choosing “Configure.”    Other options from this menu include Test and Install.    The latter brings up the Display Properties Dialog 
with WWSaver32 selected as the screen saver.



Tip: Changing image brightness

Computer monitors do not show images with consistent brightness.    If you find that images are always too dark, or always too 
bright, you can adjust the midtones up or down by using the Correct Screen Gamma option.



ReLinking Files

When files are moved to new directories, their “link” to WWSaver32 will be broken.    Any attempt to use the file from the queue will 
result in an error, as the program will not be able to find the file.    In this case, select all affected files in the queue, and then choose 
“ReLink Image File” from the File Menu.    You will see a dialog that prompts you to browse for the proper directory.    After you have 
chosen a directory, the queue will be updated to reflect this new location for the files.    If you accidentally choose an incorrect 
directory it will not hurt anything, but the files will continue to produce a “File not found” error.



Upgrading to new versions

New versions of WWSaver32 appear regularly.    Users provide good ideas for new features, and old features are always being 
improved.    When a new version is released, it is uploaded to at least the following locations:

CompuServe: Numerous forums, including WINSHARE, WINAV, GRAPHSUP, PHOTOFORUM and EFORUM.    File name is 
WWSV32.ZIP

internet:

Jumps to the WWSaver32 files are available from the WWSaver32 home page:

http://www.arcatapet.com /WWSaver32.html

Registered users are not required to re-register the program or pay any additional fees to upgrade.    Future versions will use the 
same registration key as the current version.    Registered users without access to one of the above sites may request disk copies 
from the author for a fee of $5 ($8 for non-US).

Registrants will always receive the most current version.

If you are pleased with WWSaver32, you may also be interested in other programs by the same author:

WWPlus32 is a wallpaper manager/changer that uses the same queues as WWSaver32.    WWPlus32 and WWSaver32 are “cross-
registered” programs; registrants for either program are also registered for the other.    It can be downloaded from 
http://www.arcatapet.com/wwplus32.html.    After installing, registered users should copy the registration key file from the 
WWSaver32 folder to the WWPlus32 folder to make the registration effective.

ImgViewer/32 is a graphics viewing/editing/printing program that is a great companion for WWSaver32.    When WWSaver32 finds 
ImgViewer/32 present it will enable editing functions for images selected in a queue.    It works great when associated with file types, 
which you can do from within the program.    You can find ImgViewer/32 in the same places where WWSaver32 is found, usually 
with a file name beginning with IV32 or IMGV32.    On the author's site it will be found at http://www.arcatapet.com/imgv32.html.




